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	 MÔN: TOÁN
A/. TRẮC NGHIỆM
Câu 1: Giá trị của x trong tỉ lệ thức   là:      A. 1,5            B.1,8           C.12,5        D.-15
Câu 2:  Biết x và y là hai đại lượng tỉ lệ thuận và khi x= 3 thì y = -0,5 khi đó hệ số tỉ lệ của x đối với  y là:             A.-1,5                          B. -6                       C.6                             D.     
Câu 3: Cho hình vẽ  số đo  x trong hình 1 là : 340
x
  (Hình 1)

        A. 1540          B.1260                  C.1460                             D,560


Câu 4:  Khẳng định nào sau đây là đúng? 
       A. Góc ngoài của một  tam giác bằng tổng hai góc trong của tam giác đó.
B. Trong một tam giác vuông hai góc nhọn bù  nhau.
C. Nếu một đường thẳng cắt hai đường thẳng song thì hai góc trong cùng phía phụ nhau.
D. Đường trung trực của một đoạn thẳng thì nó vuông góc với đoạn thẳng đó.
Câu 5: Cho ABC và MNP bằng nhau biết AB= NM , BC= PM . Cách viết nào sau đay là đúng:
  A. ABC =MNP          B. ABC =NMP          C.ABC = MPN          D. BCA = NMP
Câu 6: Giá trị của x trong phép tính: [image: ] là:
          A. 2                         B. 0,5                       C. -2                      D. -0,5
Câu 7: Cho x và y là hai đại lượng tỉ lệ thuận và khi x = 6 thì y = 4. Hệ số tỉ lệ k của y đối với x là:               A. k = 24	            B. k = [image: ]             C. k = [image: ]       	D. k = [image: ]
Câu 8: Hai số x và y thỏa món điều kiện [image: ] và x + y = -16 là:
        A. x = 48; y = 90     B. x = 6; y = 10     C. x = 24; y = 40     D. x = -6; y = -10
Câu 9: Cho [image: ] và [image: ]cú: [image: ]. Để [image: ] =[image: ]cần có thêm điều kiện:
   A. BC = B’C’         B. AC = A’C’       C. AB = A’B’          D. Tất cả đều đúng 
Câu 10: Cho [image: ] biết AB = 5cm; BC = 6cm. Chu vi [image: ] là 18cm. Độ dài cạnh PR là:             A. 5cm        B. 6cm           C. 7cm           D. 8cm
Câu 11: Chọn khẳng định đúng
A. Có duy nhất một đường thẳng song song với đường thẳng cho trước.
B. Nếu ba góc  của tam giác này bằng ba góc của tam giác kia thì hai tam giac đó bằng nhau.
C. Góc ngoài của tam giác lớn hơn mỗi góc trong của tam giác.
D. Mỗi đoạn thẳng chỉ có một trung trực.
Câu 13: Biết hệ số tỉ lệ thuận của x đối với y là 2. Khi x = 2 thì y bằng:
     A.                                 B. 2                         C. 1                            D. 4
Câu 14:  Cho ABC =  biết   = 450 ;   = 350  . Số đo góc B bằng:
    A. 1000                           B. 800                          C. 550                         D.350      

Câu 15: Trong các khẳng định sau, khẳng định nào sai ?
A. Nếu một đường thẳng cắt hai đường thẳng song song thì hai góc trong cùng phía bù nhau.
B. Cho a, b, c là ba đường thẳng phân biệt. Nếu a  b và b  c thì a // c.
C. Mỗi góc ngoài của một tam giác bằng tổng hai góc trong của tam giác đó.
D. Góc tạo bởi hai tia phân giác của hai góc kề bù là một góc vuông.
Câu 16:    Kết quả phép tính  là : 
	A.  			B.   				C.   	D.  
Câu 17:    Cho  | x |  =   thì 
A.  x = 		B.  x = 	    C. x =   hoặc x = -               D. x = 0 hoặc x = 
Câu 18:    Số  x  mà  2x  = (22)3   là : 
	A.  5  			B.   8			 C.   26 			D.   6   	
Câu 19:    Nếu     thì a2 bằng : 
A.  3 				B.  81 			C.  27                    D. 9
Câu 20:    Nếu đường thẳng xy là đường trung trực của đoạn thẳng AB thì : 
A. xy  AB tại I và I là trung điểm của đoạn thẳng AB	     B.  xy  AB 
C . xy đi qua trung điểm của đoạn thẳng AB			      D.Cả A, B, C đều đúng
A. 5	B. 10	C. 20	D. 25
B/. BÀI TẬP: PHẦN ĐẠI SỐ
I/. Thực hiện các phép tính: (cộng, trừ, nhân, chia, luỹ thừa với số hữu tỉ, bài tập về căn bậc hai)
Bài 1: Thực hiện phép tính (bằng cách hợp lý nếu có thể):
a) 5	d) 25 
b) 35	e)  (3,1 - 2,5) - (-2,5+3,1)
c) 	f)  
Bài 2: Tính giá trị biểu thức:
a) 	b)  	
c)  5 - 	d)  23 + 3.
e)  	f)  
g)  0,1	h)  
i)  
Bài 3: Tìm x  Q biết:
a) 	b)  
c)  5 -  = 1	d) 
e)    + 5 = –3	f)  3,8 : (2x) = 
Bài 4: Tìm x, y, z  Q biết:
a) = 	và   x + y = -32;	5x = 7y	và   y - x = 18;
b)  = 	và   2x + 3y = 69;  	 = 	và   x . y = 192;
c)  =  = 	và   x + y + z = –90;
d) 	và   x + 2y - 3z = –20;
II/. Các bài toán tỷ lệ:
1- Số học sinh của các khối 6; 7; 8; 9 của một trường THCS tỷ lệ với các số 9 : 8 : 7 : 6. Biết rằng số học sinh khối 8 và khối 9 ít hơn số học sinh khối 6 và 7 là 120 học sinh. Tính số học sinh của mỗi khối?
2- Để làm nước mơ, người ta ngâm mơ theo công thức: 2 kg mơ ngâm với 2,5 kg đường. Hỏi cần bao nhiêu kg đường để ngâm 5 kg mơ?
3- Biết độ dài các cạnh của tam giác tỷ lệ với 3 : 5 : 7. Tính độ dài mỗi cạnh của tam giác đó? Biết cạnh nhỏ nhất ngắn hơn cạnh lớn nhất 8 cm.
4- Với cùng một số tiền để mua 41 hộp bút chì loại một, có thể mua được bao nhiêu hộp bút chì loại hai? Biết rằng giá tiền một hộp bút chì loại hai chỉ bằng 82% giá tiền một hộp bút chì loại một?
III/. Tìm giá trị lớn nhất, nhỏ nhất của các biểu thức:
1- Tìm giá trị nhỏ nhất của các biểu thức :
A = 	;	B = 	;	C =  (x  -2)
2-  Tìm giá trị lớn nhất của các biểu thức:
A = 	;	B = .
IV/. Tìm x  Z để các biểu thức sau có giá trị nguyên:
A = 	;	B = 	;	C = 
C/. PHẦN HÌNH HỌC
1- Cho tia Ot là tia phân giác của góc xOy nhọn. Trên tia Ox lấy điểm E, trên tia Oy lấy điểm F sao cho OE = OF. Trên tia Ot lấy điểm H sao cho OH > OE.
a) Chứng minh  OEH =  OFH.
b) Tia EH cắt tia Oy tại điểm M, tia FH cắt tia Ox tại N. C/m:  OEM =  OFN.
c) Chứng minh EF  OH.
d) Gọi K là trung điểm của MN. Chứng minh K thuộc tia Ot. 
2- Cho  ABC có góc A = 600 và AB < AC. Trên cạnh AC lấy điểm D sao cho AD = AB. Tia phân giác  của góc A cắt BC ở E.
a) Chứng minh  ABE =  ADE.
b) AE cắt BD tại I. Chứng minh I là trung điểm của BD.
c) Trên tia AI lấy điểm H sao cho IA = IH. Chứng minh AB // HD.
d) Tính số đo góc ABD. 
3- Cho  ABC có  = 900 ( AB < AC), kẻ AH  BC (H  BC). Trên BC lấy I sao cho HI = HB. Trên tia đối  của tia HA lấy K sao cho HK = HA.
a) Chứng minh  ABH =  KIH.
b) Chứng minh AB // KI.
c) Vẽ IE  AC tại E. Chứng minh K, I, E thẳng hàng.
4- Cho  ABC có AB < AC. Trên cạnh AC lấy điểm D sao cho AD = AB. Gọi M là trung điểm của BD.
a) Chứng minh  ABM =  ADM.
b) Chứng minh AM  BD.
c) Tia AM cắt cạnh BC  tại K. Chứng minh  ABK =  ADK.
d) Trên tia đối của tia BA lấy điểm F sao cho BF = DC. Chứng minh ba điểm F, K, D thẳng hàng.

	MÔN: VẬT LÝ
I/ LÝ THUYẾT
1. Nhận biết ánh sáng – Nguồn sáng và vật sáng
    - Ta nhận biết được ánh sáng khi có ánh sáng truyền vào mắt ta.
    - Ta nhìn thấy một vật khi có ánh sáng truyền từ vật vào mắt ta.
    - Nguồn sáng là vật tự nó phát ra ánh sáng. Vật sáng gồm nguồn sáng và những vật hắt lại ánh sáng chiếu vào nó.
    Chú ý: Vật đen là vật không tự phát ra ánh sáng và cũng không hắt lại ánh sáng chiếu vào nó.
2. Sự truyền ánh sáng
    - Định luật truyền thẳng của ánh sáng:
    Trong môi trường trong suốt và đồng tính, ánh sáng truyền đi theo đường thẳng.
    - Đường truyền của ánh sáng được biểu diễn bằng một đường thẳng có mũi tên chỉ hướng gọi là tia sáng.
[image: Vật Lí lớp 7 | Chuyên đề: Lý thuyết - Bài tập Vật Lý 7 có đáp án]
    - Có 3 loại chùm sáng:
        + Chùm sáng giao nhau ⇒ chùm sáng hội tụ
        + Chùm sáng không giao nhau ⇒ chùm sáng song song
        + Chùm sáng loe rộng ra ⇒ chùm sáng phân kì
3. Ứng dụng định luật truyền thẳng của ánh sáng
    - Bóng tối nằm ở phía sau vật cản, không nhận được ánh sáng từ nguồn sáng truyền tới.
    - Bóng nửa tối nằm ở phía sau vật cản, chỉ nhận được một phần ánh sáng từ nguồn sáng truyền tới.
    - Nhật thực xảy ra khi Trái Đất bị Mặt Trăng che khuất không được Mặt Trời chiếu sáng. Nhật thực toàn phần (hay một phần) quan sát được ở chỗ có bóng tối (hay bóng nửa tối) của Mặt Trăng trên Trái Đất.
    - Nguyệt thực xảy ra khi Mặt Trăng bị Trái Đất che khuất không được Mặt Trời chiếu sáng.
4. Định luật phản xạ ánh sáng
    - Hình của một vật quan sát được trong gương gọi là ảnh của vật tạo bởi gương.
    - Hiện tượng phản xạ ánh sáng là hiện tượng ánh sáng bị hắt trở lại khi gặp một bề mặt nhẵn bóng.
    - Định luật phản xạ ánh sáng:
[image: Vật Lí lớp 7 | Chuyên đề: Lý thuyết - Bài tập Vật Lý 7 có đáp án]
        + Tia phản xạ nằm trong mặt phẳng chứa tia tới và pháp tuyến của gương tại điểm tới.
        + Góc phản xạ bằng góc tới.
5. Ảnh của một vật tạo bởi gương phẳng
    - Ảnh của một vật tạo bởi gương phẳng không hứng được trên màn chắn gọi là ảnh ảo.
    - Ảnh của một vật tạo bởi gương phẳng lớn bằng vật.
    - Khoảng cách từ một điểm của vật đến gương bằng khoảng cách từ ảnh của điểm đó đến gương.
    Chú ý:
        + Ảnh của vật là tập hợp ảnh của tất cả các điểm trên vật.
        + Các tia sáng từ điểm sáng S tới gương phẳng cho tia phản xạ có đường kéo dài đi qua ảnh ảo S’.
6. Gương cầu lồi
    - Gương cầu lồi là một phần mặt cầu, phản xạ tốt ánh sáng, có mặt phản xạ nằm phía ngoài mặt cầu.
    - Ảnh tạo bởi gương cầu lồi là ảnh ảo, nhỏ hơn vật.
    - Vùng nhìn thấy của gương cầu lồi rộng hơn vùng nhìn thấy của gương phẳng có cùng kích thước.
7. Gương cầu lõm
    - Gương cầu lõm là một phần mặt cầu, phản xạ tốt ánh sáng, có mặt phản xạ nằm phía trong mặt cầu.
    - Tác dụng của gương cầu lõm:
        + Gương cầu lõm có tác dụng biến đổi một chùm tia tới song song thành một chùm tia phản xạ hội tụ tại một điểm.
        + Gương cầu lõm có tác dụng biến đổi một chùm tia tới phân kì thích hợp thành một chùm tia phản xạ song song.
    - Ảnh tạo bởi gương cầu lõm có thể là ảnh thật hoặc ảnh ảo tùy theo vị trí của vật đối với gương.
    Ảnh ảo ⇒ Cùng chiều với vật
    Ảnh thật ⇒ Ngược chiều với vật
8. Nguồn âm
    - Vật phát ra âm gọi là nguồn âm.
    - Sự rung động (chuyển động) qua lại vị trí cân bằng gọi là dao động.
    - Các vật phát ra âm đều dao động.
9. Độ cao của âm
    - Số dao động vật thực hiện được trong 1 giây gọi là tần số.
    Đơn vị tần số là Héc (Hz).
    - Âm phát ra càng cao (càng bổng) khi tần số dao động càng lớn.
    - Âm phát ra càng thấp (càng trầm) khi tần số dao động càng nhỏ.
10. Độ to của âm
    - Độ lệch lớn nhất của vật dao động so với vị trí cân bằng của nó được gọi là biên độ dao động.
    - Biên độ dao động càng lớn, âm càng to.
    - Độ to của âm được đo bằng đơn vị đêxiben (dB).
    Chú ý:
        + Tai người chỉ nghe được âm có tần số từ 20 Hz đến 20000 Hz. Các âm có tần số nhỏ hơn 20 Hz gọi là hạ âm, các âm có tần số lớn hơn 20000 Hz gọi là siêu âm.
        + Tai người chịu được âm có độ to lớn nhất là 130 dB.
11. Môi trường truyền âm
    - Chất rắn, chất lỏng, chất khí là những môi trường có thể truyền được âm.
    - Chân không không truyền được âm.
    - Vận tốc truyền âm trong chất rắn lớn hơn trong chất lỏng, trong chất lỏng lớn hơn trong chất khí.
12. Phản xạ âm – Tiếng vang
    - Âm phản xạ là âm dội lại khi gặp một mặt chắn.
    - Âm gặp mặt chắn đều bị phản xạ nhiều hay ít. Tiếng vang là âm phản xạ nghe được cách âm trực tiếp ít nhất là 1/15 s.
    - Các vật mềm, có bề mặt gồ ghề phản xạ âm kém. Các vật cứng, có bề mặt nhẵn, phản xạ âm tốt (hấp thụ âm kém).
II/ BÀI TẬP
1. Trắc nghiệm
1. Nguồn sáng là gì?
A. Là những vật tự phát ra ánh sáng.	B. Là những vật được chiếu sáng.	
               C. Là những vật sáng.		                     D. Là những vật được nung nóng
1. Vì sao ta nhận ra vật đen? Chọn câu giải thích đúng nhất.
A. Vì vật đó không tự phát ra ánh sáng, cũng không hắt lại ánh sáng chiếu vào nó nhưng nó được đặt gần những vật sáng khác.	
B. Vì vật đó không tự phát ra ánh sáng được.	
C. Vì vật đó không trắng.	
	D. Vì vật đó tên gọi là “vật đen”.
1. Thế nào là vùng bóng tối?
A. Là vùng ở sau vật cản, không nhận được ánh sáng từ nguồn sáng chiếu tới.
            B. Là vùng chỉ nhận được một phần ánh sáng từ nguồn sáng chiếu tới.
            C. Là vùng  nhận được ánh sáng từ nguồn sáng chiếu tới.
                D. Là vùng ở trước vật cản, nhận được ánh sáng từ nguồn sáng chiếu tới.
1. Trong hiện tượng phản xạ ánh sáng, tia tới là
A. tia sáng đi từ ngoài đến mặt phản xạ của gương.
B. tia sáng từ gương tới mắt người quan sát.
C. tia kẻ vuông góc với mặt phản xạ của gương.
D. tia sáng nằm trên mặt phản xạ của gương.
1. Trong định luật phản xạ ánh sáng
A. góc phản xạ bằng góc tới.
B. tia phản xạ bằng tia tới.
C. tia phản xạ nằm trong mặt phẳng chứa tia tới và mặt phản xạ.	
                D. tia phản xạ và tia tới đều nằm trong cùng mặt phẳng gương.
1. Độ lớn ảnh của một vật tạo bởi gương phẳng
A. bằng vật						B. lớn hơn vật
C. nhỏ hơn vật					D. bằng 2 vật.
Câu 7: Ta nhìn thấy ảnh của một vật tạo bởi gương phẳng là do
A. có tia sáng từ vật đến gương, phản xạ trên gương rồi chiếu đến mắt, các tia sáng này có đường kéo dài đi qua ảnh của vật. 
B. có ánh sáng từ vật đi vòng ra sau gương rồi chiếu đến mắt ta, các tia sáng này đi qua ảnh của vật.
	C. có ánh sáng đi thẳng từ vật đến mắt ta.
D. từ mắt có các tia sáng chiếu đến gương, sau khi phản xạ trên gương thì chiếu vào vật, các tia này có đường kéo dài đi qua ảnh của vật.
Câu 9: Ảnh của một vật tạo bởi gương cầu lồi là
A. ảnh ảo, nhỏ hơn vật.				B. ảnh thật, nhỏ hơn vật.	
C. ảnh ảo, lớn bằng vật.				D. ảnh thật, lớn hơn vật.
Câu 10: Vùng nhìn thấy của một gương cầu lồi so với vùng nhìn thấy của một gương phẳng có cùng kích thước thì
           A. lớn hơn.	
B. nhỏ hơn.
C. bằng nhau.	
D. lớn hơn khi đặt mắt gần gương cầu lồi hơn.
Câu 11: Ở những đoạn đường gấp khúc có vật cản che khuất, người ta thường lắp
A. gương cầu lồi vì vùng nhìn thấy của gương cầu lồi rộng hơn vùng nhìn thấy của gương phẳng cùng kích thước.	
B. gương cầu lồi vì gương này cho ảnh rõ nét hơn gương phẳng cùng kích thước. 	
C. gương phẳng vì gương phẳng cho ảnh lớn đúng bằng vật, giúp dễ dàng trong quan sát vật. 	
D. gương cầu lồi chứ không dùng gương phẳng vì gương phẳng dễ vỡ hơn.
Câu 12: Chiếu một chùm sáng song song tới gương cầu lõm, chùm tia phản xạ thu được là chùm sáng
A. hội tụ.		B. phân kì
C. song song. 		D. truyền theo đường gấp khúc.
Câu 13: Khi gảy đàn ghita, bộ phận dao động phát ra âm thanh là
A. dây đàn.		B. không khí xung quanh dây đàn. 	
C. hộp đàn.		D. ngón tay.
Câu 14: Khi yên tĩnh, có con muỗi bay qua ta nghe thấy tiếng vo ve. Âm thanh này phát ra từ đâu? 
A. Cánh con muỗi dao động. 	
B. Miệng con muỗi dao động. 
C. Không khí trong phòng dao động.	
D. Chân con muỗi dao động.
Câu 15 Khi trời giông bão, ta thường nghe thấy tiếng sấm. Nguồn âm phát ra lúc này là do:
A. tia sét phóng qua làm không khí giãn nở mạnh.	
B. nhiều hơi nước trong không khí va chạm nhau.
C. các đám mây va chạm mạnh với nhau.	
D. tia chớp phóng qua làm đám mây giãn nở đột ngột.
Câu 16: Tần số dao động là
A. số dao động mà vật thực hiện trong 1 giây.	
B. thời gian để vật thực hiện 1 dao động.	
C. số dao động mà vật thực hiện được trong quá trình dao động.	
D. độ lệch lớn nhất của vật dao động so với vị trí cân bằng của nó.
Câu 17: Chọn phát biểu đúng.
A. Dao động càng nhanh thì tần số dao động càng lớn, âm phát ra càng cao.	
B. Dao động càng nhanh thì tần số dao động càng lớn, âm phát ra càng trầm.	
C. Dao động càng chậm thì tần số dao động càng nhỏ, âm phát ra càng cao.
D. Dao động càng nhanh thì tần số dao động càng nhỏ, âm phát ra càng trầm.
Câu 18: Trong 20 giây một lá thép thực hiện được 700 dao động. Tần số dao động của lá thép có giá trị là
A. 35Hz.	B.250Hz.                      C. 10000Hz.	D.1000Hz.
Câu 19: Đơn vị đo độ to của âm là
A. dB	
B. Hz 	
C. m/s 	
D. số dao động/giây
Câu 20: Âm không truyền được qua môi trường nào dưới đây?
A. Chân không.	B. Rắn.	C. Lỏng.	D. Khí.
Câu 21: Vật nào dưới đây phản xạ âm tốt?
A. Mặt kính.	B. Vải nhung.	C. Xốp.	D. Áo len.
Câu 22: Hãy tính độ sâu của đáy biển tại một nơi tàu neo đậu, biết thời gian kể từ lúc tàu phát ra siêu âm đến khi nhận được siêu âm phản xạ là 1,7 giây và vận tốc truyền siêu âm trong nước là 1500m/s.
A. 1275m.	B. 1000m.	C. 2250m.	D. 2000m.
II. Tự luận
Bài 1: Dựa vào tính chất ảnh của vật tạo bởi gương phẳng, hãy nêu cách vẽ và vẽ ảnh của vật sáng AB có dạng mũi tên như hình vẽ.
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Bài 2: Chiếu 1 tia tới SI tới 1 gương phẳng hợp với gương một góc 30o. Vẽ hình xác định tia phản xạ và tính góc phản xạ bằng bao nhiêu?
Bài 3: Hãy tính độ sâu của đáy biển tại một nơi tàu neo đậu, biết thời gian kể từ lúc tàu phát ra siêu âm đến khi nhận được siêu âm phản xạ là 2 giây và vận tốc truyền siêu âm trong nước là 1500m/s.
Bài 4: Trong 40 giây một lá thép thực hiện được 700 dao động. Tần số dao động của lá thép có giá trị bằng bao nhiêu?

	MÔN: TIN HỌC 
I. PHẦN TRẮC NGHIỆM
Câu 1: Trong các câu sau đây, câu nào là phần mềm bảng tính?
A. Window		B. Microsoft Word		C. Microsoft Excel		D. Tất cả sai
Câu 2: Miền làm việc chính của bảng tính là
A. Thanh công thức, hộp tên		C. Tập hợp các ô bảng tính theo chiều ngang	
B. Gồm các cột và các hàng		D. Tập hợp các ô bảng tính theo chiều dọc
Câu 3: Muốn lưu bảng tính với tên khác, em thực hiện:
A. Chọn File, Save gõ lại tên khác	B. Chọn File, Save As và gõ lại tên khác
C. Câu a và b đúng				D. Câu a và b sai
Câu 4: Công thức = B1 + C3 được đặt trong ô C4. Nếu ta sao chép công thức này sang ô D4 thì công thức trong ô D4 sẽ là:
A. = C2+ C3	B. = C1+ D3	C. = D3 + C4		D. Tất cả đều sai
Câu 5: Trên bảng tính, khi muốn di chuyển để thay đổi ô được kích hoạt em phải
A. Dùng các phím mũi tên để di chuyển		B. Sử dụng chuột để di chuyển
C. Dùng phím Backspace để di chuyển		D. Câu a, b đúng
Câu 6: Khi mở một bảng tính mới em thường thấy có
A. Một trang tính		B. Hai trang tính	C. Ba trang tính	D. Bốn trang tính
Câu 7: Khối ô có thể là
A. Một ô			B. Một dòng		C. Một cột		D. Tất cả đều đúng
Câu 8: Khi nhập công thức vào ô, em phải gõ trước công thức dấu:
A. Dấu cộng (+)		B. Dấu ngoặc đơn ( )	C. Dấu bằng (=)	D. Dấu # .
Câu 9: Kí hiệu phép nhân và phép chia trong chương trình bảng tính kí hiệu là:
A. Dấu . và :		B. Dấu . và /			C. Dấu * và :	D. Dấu * và /
Câu 10: Để kích hoạt ô D200 nằm ngoài phạm vi màn hình (em không nhìn thấy), ngoài cách dùng chuột và các thanh cuốn em có thể:
A. Gõ địa chỉ vào thanh công thức		B. Gõ địa chỉ D200 vào hộp tên
C. Nháy chuột tại nút tên cột D			D. Nháy chuột tại nút tên hàng 200
Câu 11: Cho bảng tính:
[image: bai12]a) Kết quả công thức =(A1- B1)*C1 là:
A. 29		B. 18	      C. 27	D. – 37
b) Kết quả công thức =B3/A3 +C3 là
A.11		B. 12       C. 13	D. 14
Câu 12: Cho bảng tính
[image: bai13]
a) Để tính cột tổng (H2), ta dùng công thức:
A. =Sum(C2+G2)		B. =Sum(C2:G2)	C. =Sum (C2:G2)         D. sum (C2:G2)
b) Để tính cột trung bình (I2), ta dùng công thức:
A. =Average(C5:H10)                      B. =Average(C5:H10)/5
C. =Average(C2:G2)/5                     D. =Average(C2:G2)
c) Để tìm điểm lớn nhất trong các môn học ta dùng công thức:
A. =Max(C2,G2)		B. Max(C2:G2)	C. = Max(C2:G2)	    D. =Max  (C2:G2)
d) Để tìm điểm nhỏ nhất trong các môn học ta dùng công thức:
A. =Min(C2,G2)		B. Min(C2:G2)	C. = Min (C2:G2)	    D. = Min(C2:G2).
Câu 13: Khi viết sai tên hàm trong tính toán, chương trình báo lỗi:
A. #VALUE?		B. #NAME?		C. #DIV/0?			D. #N/A!
Câu 14: Nếu trong một ô tính có các kí hiệu #####, điều đó có nghĩa gì?
A. Công thức nhập sai
B. Hàng chứa ô đó có độ cao quá thấp nên không hiển thị hết chữ số
C. Cột chứa ô đó có độ rộng quá hẹp nên không hiển thị hết chữ số
D. Cả 3 câu đều đúng
Câu 15: Muốn chọn hai khối không kề nhau ta nhấn cần nhấn giữ phím:
A. Shift 		B. Alt				C. Enter		D. Ctrl
Câu 16: Có mấy bước thực hiện nhập công thức vào ô tính?
A. 2 bước		B. 3 bước			C. 4 bước		D. 5 bước
Câu 17: Em có thể lưu bảng tính trên máy tính bằng cách xử dụng lệnh :
A. File → Save	B. File → Frint		C. File → Open	D.    File → Close
Câu 18: Để chọn đối tượng trên trang tính ,em thực hiện như thế nào ?
Hãy nối cột A với cột B để được phương án đúng .
	A
	B

	1. Chọn một ô
	A. nháy chuột tại nút tên hàng

	2. Chọn một hàng
	B. nháy chuột tại nút tên cột

	3. Chọn một cột
	C. đưa con trỏ chuột tới ô đó và nháy chuột .


Câu 19: Để tính tổng giá trị trong các ô C1 và C2, sau đó chia cho giá trị trong ô B3:
A. = (C1 + C2 ) \ B3;		B. (C1 + C2 ) / B3;	
C. = C1 + C2 \ B3;			D. = (C1 + C2 ) / B3.
Câu 20: Cách nhập hàm nào sau đây là sai :
A. = MIN(A1,A2,A3);              B. = MIN(A1:A3);
C. = MIN(A1:A2,A3);              D. = MIN (A1:A3).
Câu 21: Giả sử cần tính trung bình cộng giá trị của các ô B1,C1và E1 .
Công thức nào trong các công thức sau đây là sai :
A. = SUM(B1,C1,E1)/3;        	B. = AVERAGE (B1,C1,E1);
C. = (B1+C1+E1)/3;              	D . = AVERAGE (B1: C1,E1)
Câu 22: Để mở 1 trang tính mới ta phải thực hiện như thế nào ?
A. File → New;		B. File → Exit;	C. File →Open;	D. File → Close;
Câu 23: Ô tính A1 có nội dung =AVERAGE(C10:C12). Nếu dùng công thức thì sẽ là:
A. =(C10+C11+C12)/3		C. =C10+C11+C12
B. =(C10:C12)/3			D. =SUM(C10:C12)
Câu 24: Ô C3 có công thức =A3+B3. Nếu em sao chép ô C3 sang ô C5 thì ở ô C5 sẽ là:
A. =A3+B3       B. =A5+B5            C. =C6+D3           D. =B3+A3
[image: bai29]Câu 25: Địa chỉ của khối ô đang được chọn là:
A. A1,C5	B. A1;C5		C. A2.C5	D. A1:C5
Câu 26: Để xóa hàng hay cột ta dùng lệnh:
A. Delete				B. Edit → Delete
C. File → Open			D. File → Close
[image: bai30]Câu 27: Cho bảng tính:
a)  Kết quả công thức =A1-B1+C1 là
A. -8		B. 8		C. 6		D. -6
b) Kết quả công thức =A3*B3-C3 là
A. 79		B. 70		C. 69		D. 68
Câu 28: Để sao chép dữ liệu trong ô hoặc khối ô ta dùng lệnh :
A. Cut, Paste		B. File, save		C. Copy, Paste		D. Edit, delete
Câu 29: Phần mềm Typing Test dùng để:
A. Luyện gõ phím nhanh bằng 10 ngón tay		B. Học địa lý thế giới
Câu C. Học toán học					D. Học vẽ hình hình học động
Câu 30: Để chèn thêm hàng ta dùng lệnh:
A. Insert / Rows	B. Insert / Columns	C. Table / Columns       D. Table / Rows

II. PHẦN TỰ LUẬN:
Câu 1. Chương trình bảng tính là gì?
Câu 2. Nêu các bước nhập công thức vào ô tính? Từ đâu có thể biết một ô chứa công thức hay chứa giá trị cụ thể? Lợi ích của việc sử dụng địa chỉ trong công thức.
Câu 3. Trên trang tính:
a) Hãy nêu thao tác điều chỉnh tăng độ rộng của cột B
b) Để điều chỉnh độ rộng cột vừa khít với dữ liệu có trong ô C5 ta cần làm thế nào?
Câu 4. Hãy nêu các bước thực hiện thao tác sao chép dữ liệu, di chuyển dữ liệu.
Câu 5. Giả sử khối cần sao chép là A3:B5, khối nhận dữ liệu sao chép là ô B6:C8. Để sao chép bằng cặp lệnh Copy – Paste và kết thúc việc sao chép, thao tác cần thực hiện như thế nào?
Câu 6. Giả sử khối cần di chuyển là A2:B4, khối nhận dữ liệu di chuyển là ô A6:B8. Để di chuyển bằng cặp lệnh Cut – Paste và kết thúc việc di chuyển, thao tác cần thực hiện như thế nào?
Câu 7. Cho dữ liệu như sau: 
[image: tin]
Em hãy:
a) Lập công thức để tính tổng điểm của mỗi bạn?
b) Lập công thức để tính điểm trung bình của mỗi bạn?
c) Lập công thức để tìm điểm cao nhất cho mỗi môn học?
d) Lập công thức để tìm điểm thấp nhất cho mỗi môn học?

----------Chúc các con ôn thi tốt!----------


	MÔN: SINH HỌC
PHẦN I. NỘI DUNG KIẾN THỨC
	Các đơn vị kiến thức đã học từ Bài 1: Thế giới động vật đa dạng và phong phú đến hết Bài 28: Thực hành: Xem băng hình về tập tính của sâu bọ. (Trừ các phần, các bài giảm tải).
II. MỘT SỐ DẠNG BÀI TẬP MINH HỌA
1. Câu hỏi tự luận
Câu 1: Trình bày cấu tạo ngoài của tôm sông, nhện, châu chấu thích nghi với đời sống.
Câu 2: Nêu vai trò của một số đại diện lớp Giáp xác, lớp Hình nhện.
Câu 3: Trình bày các biện pháp phòng bệnh kiết lị và bệnh sốt rét.
Câu 4: a, Cấu tạo của sán lá gan thích nghi với đời sống kí sinh như thế nào?
   b, Vì sao trâu bò nước ta hay bị mắc bệnh sán lá gan?
Câu 5: Vai trò thực tiễn của giun đốt thường gặp ở địa phương.
2. Câu hỏi trắc nghiệm
Câu 1. Động vật nguyên sinh có lối sống tự dưỡng là 
A. trùng giày.         B. trùng roi xanh.      C. trùng biến hình.        D. trùng sốt rét.
Câu 2. Loài giun dẹp nào dưới đây sống kí sinh trong máu người?
A. Sán bã trầu.       B. Sán lá gan. 	   C. Sán dây.                    D. Sán lá máu. 
Câu 3. Loài chân khớp nào có lối sống cộng sinh?
A. Ve sầu.            B. Tôm ở nhờ.           C. Nhện.                       D. Cua nhện.
Câu 4 Thức ăn của giun đất là gì?
A. Vụn thực vật và mùn đất.	B. Chất dinh dưỡng trong ruột của vật chủ.
C. Động vật nhỏ trong đất.	D. Rễ cây.
 Câu 5. Ở nhiều ao thả cá, tại sao không thả trai mà tự nhiên có trai vì ấu trùng trai
A. thường sống trong bùn đất, sau đó phát triển thành trai trưởng thành.
B. vào ao theo nước mưa, sau đó phát triển thành trai trưởng thành.
C. bám vào mang và da cá, sau đó rơi xuống bùn phát triển thành trai trưởng thành.
D. kí sinh trong ốc vặn, sau đó theo đường tiêu hóa của ốc ra ngoài môi trường nước phát triển thành trai trưởng thành.
Câu 6. Động vật đơn bào nào dưới đây sống tự do ngoài thiên nhiên?
A. Trùng sốt rét.    		  	B. Trùng kiết lị.
C. Trùng biến hình.      		D. Trùng roi máu.
Câu 7. Loài giun nào gây ra bệnh chân voi ở người?
A. Giun móc câu.           B. Giun kim.		C. Giun đũa.       D. Giun chỉ.               
Câu 8. Sứa bơi lội trong nước biển nhờ
A. tua miệng phát triển, cử động linh hoạt.    B. cơ thể có tỉ trọng xấp xỉ nước.
C. dù có khả năng co bóp.        			D. cơ thể đối xứng tỏa tròn.
Câu 9. Loài giun nào thường sống thành búi ở các cống rãnh?
A. rươi.       	  B. giun đất .            C. giun chỉ.			D. giun đỏ.          
Câu 10. Trong điều kiện tự nhiên, bào xác trùng kiết lị có khả năng tồn tại trong bao lâu?
A. 3 tháng.         B. 6 tháng.		C. 9 tháng.         D. 12 tháng.
Câu 11. Khi sống trong ruột mối, trùng roi sẽ
A. gây bệnh đường ruột cho mối.    	
B. tiết enzim giúp mối phân giải xenlulozo.
C. gây mùi cho phân mối.        		
D. ăn hết chất dinh dưỡng của mối.
Câu 12. Giun đất có hệ sinh dục lưỡng tính nhưng thụ tinh theo hình thức nào?
A. Tự thụ tinh.    			B. Thụ tinh ngoài.		
C. Thụ tinh chéo.        		D. Hình thức khác.
Câu 13. Đảo ngầm san hô thường gây tổn hại gì cho con người?
A. Cản trở giao thông đường thuỷ.	
B. Tranh thức ăn với các loại hải sản con người nuôi 
C. Gây ngứa và độc cho người.		
D. Tiết chất độc làm hại cá và hải sản nuôi.
Câu 14. Nhóm động vật nào thuộc ngành giun tròn?
A. Giun kim, giun chỉ, giun đỏ.    		B. Giun kim, giun chỉ, giun móc câu. C. Giun kim, giun chỉ, đỉa.      		D. Giun kim, giun chỉ, rươi.
Câu 15. Nhóm nào dưới đây gồm toàn những sâu bọ sống ở môi trường nước?
A. Ấu trùng ve sầu, bọ gậy, bọ rầy.	B. Bọ vẽ, ấu trùng chuồn chuồn, bọ gậy.
C. Bọ gậy, ấu trùng ve sầu, dế trũi.	D.Ấu trùng chuồn chuồn, bọ gậy, bọ ngựa.
 Câu 16. Ý nghĩa sinh học của tập tính đào lỗ đẻ trứng của ốc sên là gì?
A. Bảo vệ trứng khỏi kẻ thù.    			B. Để tăng nhiệt độ ấp trứng.
C. Để trứng nở nhanh hơn.        			D. Để giảm nhiệt độ ấp trứng.
Câu 17. Do thói quen nào của trẻ mà giun kim khép kín được vòng đời?
A. Ngoáy mũi.        		       B. Xoắn và giật tóc.
C. Cắn móng tay, mút ngón tay.       D. Đi chân đất dẫn đến bị lạnh và đau bụng.
Câu 18. Câu thơ sau đây nói đến loài động vật nào thuộc lớp Sâu bọ?
“ Con gì mải miết rong chơi
         Tiếng kêu ra rả gọi mời hè sang”
A. Ve sầu.           B. Bọ ngựa.                 C. Châu chấu.                 D. Ve bò.
Câu 19. Những người lao động ( thợ mỏ, nông dân) dễ bị nhiễm giun móc câu vì ấu trùng xâm nhập vào cơ thể người qua
A. đường tiêu hóa.				B. qua da bàn chân.
C. đường hô hấp.				D. đường máu.
Câu 20. Cơ thể của nhện được chia thành
A. 3 phần là phần đầu, phần ngực và phần bụng.
B. 2 phần là phần đầu và phần bụng.
C. 2 phần là phần đầu – ngực và phần bụng.
D. 3 phần là phần đầu, phần bụng và phần đuôi.


	MÔN: NGỮ VĂN
Ôn tập kiến thức đã học từ tuần 1 đến tuần 14 (SGK Ngữ văn 7 tập I)
A. KIẾN THỨC TRỌNG TÂM
Phần I. Văn bản
1. Thơ trung đại: Sông núi nước Nam, Qua Đèo Ngang, Bạn đến chơi nhà.
2. Thơ hiện đại: Cảnh khuya, Rằm tháng giêng, Tiếng gà trưa.
3. Tùy bút: Một thứ quà của lúa non: Cốm
* Yêu cầu:
- Nắm được tác giả, tác phẩm, thể loại, hoàn cảnh sáng tác, phương thức biểu đạt, bố cục, thuộc thơ, mạch cảm xúc...
- Nắm được nội dung, nghệ thuật, biết khai thác tín hiệu nghệ thuật, những chi tiết hình ảnh đạc sắc trong văn bản để làm nổi bật nội dung.
Phần II. Tiếng Việt
1. Từ ghép, từ láy, đại từ, từ Hán Việt, quan hệ từ, từ đồng nghĩa, từ trái nghĩa, từ đồng âm.
2. Thành ngữ.
3. Điệp ngữ.
* Yêu cầu:
- Nhận diện được đơn vị kiến thức tiếng Việt cơ bản trong văn bản.
- Nêu vai trò, tác dụng của các đơn vị kiến thức trong văn bản.
- Vận dụng kiến thức trong thực hành nói và viết.
Phần III: Tập làm văn: Văn biểu cảm về tác phẩm văn học.
* Yêu cầu: 
- Nắm vững đặc điểm thể loại văn biểu cảm về tác phẩm văn học.
- Lập được dàn ý và viết bài văn biểu cảm hoàn chỉnh.
(Lưu ý: các dạng bài tập vận dụng kiến thức đã học vào việc giải quyết các vấn đề thực tiễn.)

B. MỘT SỐ DẠNG BÀI TẬP
Bài tập 1
a. Chép chính xác bài thơ “Bạn đến chơi nhà” của tác giả Nguyễn Khuyễn, giới thiệu ngắn gọn về thể thơ.
b. Chỉ ra biện pháp nghệ thuật trong hai câu thơ  sau và nêu tác dụng:
	“Cải chửa ra cây, cà mới nụ
	Bầu vừa rụng rốn, mướp đương hoa”
c. Nêu ý nghĩa của cụm từ “ta với ta” kết thúc bài “Qua Đèo Ngang” và bài “Bạn đến chơi nhà”.
d. Qua bài thơ “Bạn đến chơi nhà”, hãy nêu suy nghĩ của em về một tình bạn đẹp.
Bài tập 2
a. Chép chính xác bản phiên âm bài thơ “Rằm tháng giêng” của Hồ Chí Minh. Cho biết phương thức biểu đạt và thể thơ.
b. Xác định những biện pháp nghệ thuật được sử dụng trong hai câu thơ đầu bài thơ “Rằm tháng giêng” và cho biết tác dụng.
Bài tập 3: 
a. Chép chính xác bài thơ “Cảnh khuya” của Hồ Chí Minh. Cho biết hoàn cảnh ra đời của bài thơ.
b. Xác định những biện pháp nghệ thuật được sử dụng trong hai câu thơ đầu bài thơ “Cảnh khuya” và cho biết tác dụng.
c. Qua bài thơ “Cảnh khuya”, em hiểu thêm điều gì về con người Bác. Từ đó, em thấy cần làm gì để học tập và làm theo tư tưởng, đạo đức, phong cách Hồ Chí Minh.
Bài tập 4: Cho câu thơ “Trên đường hành quân xa”
a. Hãy chép tiếp 6 câu thơ để hoàn chỉnh khổ thơ đầu bài thơ “Tiếng gà trưa” của Xuân Quỳnh.
b. Chỉ ra các biện pháp nghệ thuật được sử dụng trong đoạn thơ vừa chép và nêu tác dụng.
c. Qua bài thơ em có nhận xét gì về người bà và tình cảm bà cháu? Từ đó, theo em cần phải làm gì để bày tỏ lòng biết ơn đối với ông bà, cha mẹ.
Bài tập 5:
Đọc đoạn trích sau và trả lời câu hỏi:
	“Ai đã nghĩ đầu tiên dùng cốm để làm quà sêu tết. Không có gì hợp hơn với sự vương vít của tơ hồng, thức quà trong sạch, trung thành như các việc lễ nghi. Hồng cốm tốt đôi…Và không bao giờ có hai màu lại hòa hợp hơn được nữa: màu xanh tươi của cốm như ngọc thạch quý, màu đỏ thắm của hồng như ngọc lựu già. Một thứ thanh đạm, một thứ ngọt sắc, hai vị nâng đỡ nhau để hạnh phúc được lâu bền. (Thật đáng tiếc khi chúng ta thấy những tục lệ tốt đẹp ấy mất dần, và những thức quý của đất mình thay dần bằng những thức bóng bẩy hào nháng và thô kệch bắt chước người ngoài…)”
			(Sách giáo khoa Ngữ văn 7 tập 1 – trang 160)
a. Đoạn trích trên nằm trong văn bản nào? Tác giả là ai?
b. Qua đoạn trích em thấy được cốm có giá trị gì? Hồng và cốm có sự hòa hợp, tương xứng như thế nào? 
c. Tác giả có nêu suy nghĩ: “Thật đáng tiếc khi chúng ta thấy những tục lệ tốt đẹp ấy mất dần, và những thức quý của đất mình thay dần bằng những thức bóng bẩy hào nháng và thô kệch bắt chước người ngoài…”, em có đồng ý với suy nghĩ đó không? Theo em, chúng ta cần làm những gì để gìn giữ bản sắc văn hóa của dân tộc?
Bài tập 6: Chỉ ra lỗi sử dụng quan hệ từ trong các câu văn sau và chữa lại cho đúng:
a. Dưới ngòi bút của mình, Nguyễn Trãi đã dựng lên cảnh Côn Sơn thật là nên thơ.
b. Qua câu ca dao “Công cha như núi Thái Sơn, Nghĩa mẹ như nước trong nguồn chảy ra” cho ta thấy công lao to lớn của cha mẹ đối với con cái.
c. Chúng ta phải sống cho thể nào để chan hòa với mọi người.
d. Đừng nên nhìn hình thức đánh giá kẻ khác.
Bài tập 7: Giải thích nghĩa các thành ngữ sau đây và đặt câu có sử dụng thành ngữ đó:
a. Một nắng hai sương
b. Lên thác xuống ghềnh 
c. Con Rồng, cháu Tiên
d. Ếch ngồi đáy giếng
Bài tập 8: Biểu cảm về bài thơ “Cảnh khuya” của Hồ Chí Minh.
Bài tập 9: Biểu cảm về bài thơ “Rằm tháng giêng” của Hồ Chí Minh.
Bài tập 10: Biểu cảm về tình bà cháu trong bài thơ “Tiếng gà trưa” của Xuân Quỳnh
Gợi ý: 
Bài tập 1
a. HS tự làm
b. BPNT: phép đối, liệt kê
Tác dụng: làm nổi bật tình huống khó xử của nhà thơ khi bạn đến chơi, ngay cả rau quả cũng không có để đãi bạn. Từ đó khẳng định tình bạn đậm đà, thắm thiết, tri kỷ.
c. Ý nghĩa của cụm từ “ta với ta”:
- Bài thơ “Qua Đèo Ngang”: bộc lộ tâm trạng buồn, cô đơn của tác giả 
- Bài thơ “Bạn đến chơi nhà”: khẳng định tình bạn tri kỷ, tuy hai mà một.
d. HS tự làm 
Bài tập 2
a. HS tự làm
b. BPNT: điệp ngữ , liệt kê 
- Tác dụng: Làm nổi bật bức tranh thiên nhiên rộng lớn, tràn đầy sức sống của mùa xuân. Qua đó bộc lộ tình yêu thiên nhiên, tinh thần lạc quan của Bác.
Bài tập 3
a, c. HS tự làm
b. Xác định những biện pháp nghệ thuật được sử dụng trong hai câu thơ đầu bài thơ “Cảnh khuya” và cho biết tác dụng.
- BPNT: So sánh “Tiếng suối trong như tiếng hát xa”, điệp ngữ “lồng”
- Tác dụng: 
+ Miêu tả âm thanh tiếng suối: trong trẻo, du dương, trầm bổng và rất gần gũi với con người
+ Vẽ ra bức tranh thiên nhiên núi rừng Việt Bắc lung linh huyền ảo, nhiều tầng cảnh…
+ Tình yêu thiên nhiên, tinh thần lạc quan của Bác.
Bài tập 4: Cho câu thơ “Trên đường hành quân xa”
a. HS tự làm
b. Chỉ ra các biện pháp nghệ thuật được sử dụng trong đoạn thơ vừa chép và nêu tác dụng.
- BPNT: điệp ngữ, ẩn dụ “Nghe”
- Tác dụng:
+ Nhấn mạnh âm thanh tiếng gà gợi nhiều xúc động đối với người chiến sĩ
+ Tiếng gà tiếp thêm sức mạnh giúp người chiến sĩ vững bước trên đường hành quân ra trận
+ Tiếng gà đánh thức những kỳ niệm đẹp của tuổi thơ
-> Âm thanh tiếng gà giản dị, quen thuộc mà mang nhiều ý nghĩa sâu sắc
c. Nhận xét về tình bà cháu:
- Bà giàu tình yêu thương, giàu đức hi sinh, chăm lo cho cháu
- Cháu yêu quý, kính trọng, hiếu thảo với bà
-> Tình cảm gia đình làm sâu sắc thêm tình yêu quê hương, đất nước. 
Bài tập 5:
b. Qua đoạn trích em thấy được cốm có giá trị để làm quà sêu tết, được dùng trong các việc lễ nghi. Hồng và cốm có sự hòa hợp, tương xứng: màu sắc xanh tươi và đỏ thắm, vị thanh đạm với ngọt sắc. 
Bài tập 6,7: HS tự làm


Bài tập 8: Biểu cảm về bài thơ “Cảnh khuya” của Hồ Chí Minh.
1. Mở bài
- Giới thiệu về bài thơ Cảnh khuya của Hồ Chí Minh
- Nêu cảm nhận chung của em về bài thơ
2. Thân bài
a. Vẻ đẹp thiên nhiên trong hai câu đầu
- NT so sánh tiếng suối thì thầm, róc rách, vang vọng như tiếng hát, tiếng ca ngọt ngào. Tưởng tượng âm thanh tiếng suối du dương, trầm bổng. Thiên nhiên sinh động, gần gũi.
- Điệp ngữ “lồng” ánh trăng chiếu xuống cây cổ thụ, bóng cây cổ thụ in xuống khóm hoa. Thiên nhiên đan cài, quấn quýt… 
=> Cảnh đêm trăng Việt Bắc thơ mộng, hữu tình, đẹp đẽ gợi cảm, có âm thanh, có hình sắc.
b. Vẻ đẹp tâm hồn người cách mạng qua hai câu cuối
Điệp ngữ “chưa ngủ” nhấn mạnh Bác không ngủ:
+ Bởi thiên nhiên quá đẹp
+ Bởi lòng vẫn đang nặng trĩu nỗi lo toan cho dân tộc
=> Tinh thần lạc quan, phong thái ung dung, tâm hồn thi sĩ hòa quyện với phẩm chất chiến sĩ trong con người Bác
3. Kết bài
- Cảm nghĩ về nghệ thuật, nội dung bài thơ
- Từ đó ta thấy Bác có tình yêu thiên nhiên, đất nước sâu nặng
Bài tập 9: Biểu cảm về bài thơ “Rằm tháng giêng” của Hồ Chí Minh.
1. Mở bài
- Giới thiệu về bài thơ Rằm tháng giêng của Hồ Chí Minh
- Nêu cảm nhận chung của em về bài thơ
2. Thân bài
a. Cảm nghĩ về 2 câu thơ đầu:
- Thời gian: hình ảnh “nguyệt chính viên” - khi trăng tròn nhất. Khi đêm vào khuya, trăng đã lên cao tỏa ánh sáng xuống mọi vật. Đây là đêm rằm đầu tiên của năm.
→ Miêu tả không gian rộng lớn, thoáng đãng, tràn ngập ánh sáng dìu dịu của mặt trăng.
- Nghệ thuật điệp ngữ từ “xuân”: hình ảnh thiên nhiên “xuân giang”, “xuân thủy”, “xuân thiên” - sông xuân, nước xuân, trời xuân
→ Những từ xuân được lặp lại để khẳng định mùa xuân, sắc xuân đang tràn ngập khắp nơi
b. Cảm nghĩ về 2 câu thơ cuối:
- Hình ảnh con người: “bàn bạc việc quân” - hình ảnh con người là những chiến sĩ - tập trung bàn bạc, lo lắng cho việc nước, việc dân - dù là trong đêm trăng đẹp đến như vậy.
- Thời gian:
+ “dạ bán quy lai” - đêm đã trôi qua một nửa
+ “nguyệt mãn thuyền” - ánh trăng rải đều lên mặt thuyền - trăng đã lên đến đỉnh - thời điểm khuya nhất của đêm
→ Các chiến sĩ đã bàn bạc hăng say, tập trung đến rất khuya thể hiện tinh thần quyết tâm, lo lắng cho tổ quốc
→ Hình ảnh ánh trăng sáng trải đầy thuyền còn tượng trưng cho tương lai sáng rọi phía trước của đất nước khi có những con người hết lòng vì tổ quốc như vậy.
- Hình ảnh song hành trăng - con người (nghệ sĩ - chiến sĩ) khẳng định sự giao hòa cảm xúc của nhà thơ: vừa là chiến sĩ hết lòng vì đất nước, vừa là nhà thơ với tâm hồn nhạy cảm.
3. Kết bài
- Cảm nghĩ về nghệ thuật, nội dung bài thơ
- Từ đó ta thấy Bác có tình yêu thiên nhiên, đất nước sâu nặng
Bài tập 10: Biểu cảm về bài thơ “Tiếng gà trưa” của Xuân Quỳnh. 
1. Mở bài
- Giới thiệu khái quát về tác giả, tác phẩm, hoàn cảnh sáng tác
- Nêu ngắn gọn vảm nghĩ về tác phẩm
2. Thân bài 
a. Cảm nghĩ về tiếng gà trưa trên đường hành quân
- Hoàn cảnh: trên đường hành quân xa, dừng chân bên xóm nhỏ
- Cảm nghĩ về âm thanh tiếng gà trưa: “Cục…cục tác cục ta” gần gũi, giản dị, gợi bao xúc động.
- Nghệ thuật điệp từ, ẩn dụ chuyển đổi cảm giác: gợi tâm trạng xốn xang, tiếp thêm sức mạnh chiến đấu cho người chiến sĩ và tiếng gà trưa gọi về kỉ niệm tuổi thơ.
b. Tiếng gà trưa gợi lại những kỉ niêm thời thơ ấu
- Những kỉ niệm tuổi thơ
+ Hình ảnh con gà mái mơ, mái vàng và ổ trứng hồng đẹp như tranh
+ Kỉ niệm: tò mò xem gà đẻ bị bà mắng
+ Hình ảnh bà đầy yêu thương, chắt chiu, dành dụm từng quả trứng cho cháu
+ Niềm vui và mong ước nhỏ bé của tuổi thơ: được quần áo mới
⇒ Những kỉ niệm tuổi thơ bình dị, gần gũi, hồn nhiên không thể nào quên của gia đình làng quê Việt Nam.
- Hình ảnh người bà và tình bà cháu
+ Bà mắng: “Gà đẻ…mặt”
⇒ Lời mắng xuất phát từ tình yêu thương, sự quan tâm, chăm soc của bà dành cho cháu
+ Bà chắt chiu trong cảnh nghèo khó, dành trọn vẹn tình yêu thương, sự chăm lo cho cháu: “Tay bà khum soi trứng … Cháu được quần áo mới”
⇒ Tình bà cháu thật sâu nặng, thắm thiết, bà chắt chiu, chăm lo, quan tâm cho cháu, cháu luôn yêu thương, kính trọng bà
c. Tiếng gà trưa gợi những suy tư
- Tiếng gà trưa mang đến hạnh phúc vì nó làm thức dậy biết bao tình cảm cao đẹp: tình bà cháu, tình xóm làng, tình cảm gia đình… Niềm hạnh phúc ấy đem vào giấc ngủ hồng sắc trứng
- Nghệ thuật điệp từ và điệp cấu trúc (vì lòng yêu Tổ quốc, vì xóm làng thân thuộc, vì bà…): qua đó, nhấn mạnh mục đích chiến đấu vừa cao cả và thiêng liêng nhưng cũng hết sức bình dị, cụ thể
- Tình cảm gia đình, quê hương đã làm sâu sắc thêm tình yêu Tổ quốc
III. Kết bài
- Khái quát giá trị nội dung và nghệ thuật của bài thơ:
+ Nội dung: Tiếng gà trưa đã gọi về những kỉ niệm đẹp đẽ của tuổi thơ và tình bà cháu. Tình cảm gia đình đã làm sâu sắc thêm tình quê hương đất nước
+ Nghệ thuật: thể thơ 5 chữ, điệp ngữ, hình ảnh thơ bình dị, gần gũi…


	MÔN: LỊCH SỬ
I. NỘI DUNG TRỌNG TÂM:
1. Bài 11: Cuộc kháng chiến chống quân xâm lược Tống (1075-1077).
2. Bài 13: Nước Đại Việt thế kỉ XIII.
3. Bài 14: Ba lần kháng chiến chống quân xâm lược Nguyên - Mông (thế kỉ XIII)
II. HÌNH THỨC KIỂM TRA
- 100% trắc nghiệm khách quan
- Số lượng câu hỏi: 30 câu với 3 mức độ nhận thức: nhận biết - thông hiểu - vận dụng.
- Thời gian làm bài: 45 phút.
III. HƯỚNG DẪN CỤ THỂ
Câu 1. Nhà Lý  thực hiện chủ trương “tiến công trước để tự vệ” nhằm mục đích gì? Nêu cách thức thực hiện? Kết quả? Ý nghĩa?
Câu 2. Nhà Trần thành lập trong hoàn cảnh nào? Nêu những biện pháp để củng cố chế độ phong kiến tập quyền của nhà Trần?
Câu 3. Hoàn thành bảng so sánh 3 lần kháng chiến chống quân xâm lược Mông Nguyên của nhà Trần.
	Nội dung
	Lần 1 (1258)
	Lần 2 (1285)
	Lần 3
(1287 – 1288)

	Âm mưu của nhà Mông – Nguyên
	
	
	

	Sự chuẩn bị của nhà Trần
	
	
	

	Những trận đánh tiêu biểu
	
	
	

	Nguyên nhân thắng lợi
	

	Ý nghĩa lịch sử
	



IV. CÂU HỎI THAM  KHẢO
Câu 1. Ai là người đề ra chủ trương “Ngồi yên đợi giặc không bằng đem quân đánh trước để chặn thế mạnh của giặc”?
A. Lý Thường Kiệt.				B. Trần Thủ Độ.	
C. Trần Hưng Đạo.				D. Trần Thánh Tông.
Câu 2. Nhà Lý gả công chúa và ban chức tước cho các tù trưởng dân tộc nhằm mục đích gì?
A. Kết thân với các tù trưởng, tăng thêm uy tín, quyền lực của mình.
B. Củng cố khối đoàn kết dân tộc, tạo sức mạnh trong việc xây dựng và bảo vệ Tổ quốc.
C. Với tay nắm các vùng dân tộc ít người.
D. Kéo các tù trưởng về phía mình, tăng thêm sức mạnh chống ngoại xâm.
Câu 3. Khi Mông Cổ cho sứ giả đến đưa thư dụ hàng vua Trần, thái độ của vua Trần như thế nào?
A. Trả lại thư.				B. Gửi thư giảng hoà.
C. Bắt giam sứ vào ngục.			D. Chém đầu sứ giả.
Câu 4. Câu nói: “ Nếu bệ hạ muốn hàng giặc thì trước hãy chém đầu thần rồi hãy hàng” là của vị tướng nào dưới thời Trần?
A. Trần Quốc Tuấn.				B. Trần Khánh Dư.
C. Trần Anh Tông.				D. Trần Cảnh.
Câu 5. Giữa thế kỉ XI, nhà Tống thường bị hai nước nào quấy nhiễu?
	A. Hai nước Minh – Thanh			B. Hai nước Liêu – Hạ
	C. Hai nước Thục – Ngô			D. Hai nước Sở - Hán
Câu 6. Giữa thế kỉ XI, Nhà Tống đã giải quyết những khó khăn trong nước bằng cách nào?
	A. Đánh hai nước Liêu – Hạ		B. Xâm lược Đại Việt
	C. Tấn công Cham – pa			D. Tất cả các đáp án trên
Câu 7. Ai là người chỉ huy cuộc kháng chiến chống Tống những năm 1075 – 1077?
	A. Lý Công Uẩn				B. Lý Thánh Tông
	C. Lý Nhân Tông				D. Lý Thường Kiệt
Câu 8. Sau khi tấn công thành Ung Châu thắng lợi. Lý Thường Kiệt về nước cho xây dựng hệ thống phòng ngự ở đâu?
	A. Sông Bạch Đằng			B. Sông Mã
	C. Sông Như Nguyệt			D. Sông Thao
Câu 9. Lý Thường Kiệt chủ động kết thúc chiến tranh bằng cách nào?
	A. Thương lượng, đề nghị “giảng hòa”	 
         B.Tiêu diệt quân Tống đến cùng
	C. Kí hòa ước kết thúc chiến tranh		
         D. Giảng hòa để tập hợp lực lượng chờ thời cơ
Câu 10. Một chế độ đặc biệt chỉ có trong triều đình nhà Trần, đó là chế độ gì?
	A. Chế độ lập Thái tử sớm		B. Chế độ nhiều Hoàng hậu
	C. Chế độ Thái thượng hoàng		D. Chế độ Nhiếp chính vương

	MÔN : ĐỊA LÍ 
 I. Kiến thức trọng tâm
1. Môi trường hoang mạc
2. Môi trường đới lạnh
3. Môi trường vùng núi
4. Thiên nhiên Châu Phi
5. Dân cư, xã hội Châu Phi
6. Kinh tế Châu Phi 
II. Một số câu hỏi trắc nghiệm minh họa
Câu 1: Hoang mạc hết sức khô hạn của thế giới nằm ở
A. Trung Á.                				 B.   Ô-xtrây-li-a.             
C.  Nam Mĩ.                				 D.   Bắc Phi.                      
Câu 2: Những nơi có tốc độ hoang mạc hóa nhanh nhất là
A. ở rìa các hoang mạc đới nóng có mùa khô kéo dài.
B. bên trong các hoang mạc đới nóng có nhiệt độ cao quanh năm.
C. ở các hoang mạc ôn đới khô khan.
D. ở đới lạnh.
Câu 3: Vấn đề lớn của đới lạnh hiện nay là
A.thiếu nhân lực.
B. thiếu phương tiện vận chuyển và kĩ thuật hiện đại. 
C. nguy cơ tuyệt chủng một số động vật quí.
D. cả A và C đều đúng.
Câu 4: Tính chất đặc trưng của khí hậu hoang mạc là
A. mưa theo mùa.                                             B. nắng nóng quanh năm.
C. rất khô hạn.                                                  D. rất giá lạnh.
Câu 5: Giới hạn của đới lạnh là
A. từ vòng cực đến cực.                                   B. từ xích đạo đến chí tuyến.
C. từ chí tuyến đến vòng cực.                          D. từ 50 B đến 50N.
Câu 6: Châu Phi không tiếp giáp với biển, đại dương nào?
A. Thái Bình Dương	B. Ấn độ Dương	C. Biển đỏ	D. Đại tây dương
Câu 7: Khí hậu và thực vật ở vùng núi thay đổi theo
A. mùa và vĩ độ.	 			            B. độ cao và hướng sườn.   
C. đông – tây và bắc - nam.			  D. vĩ độ và độ cao.
Câu 8: Loài động vật nào sau đây không sống ở đới lạnh?
A. sư tử.		B. tuần lộc.		C. gấu bắc cực.	D. chim cánh cụt.
Câu 9: Các hoang mạc trên thế giới thường phân bố ở 
A. dọc theo đường xích đạo.			
B. từ vòng cực về cực.
C. vùng ven biển và khu vực xích đạo.	 
D. dọc theo hai đường chí tuyến và giữa lục địa Á – Âu.
Câu 10: Châu Phi có khí hậu nóng do
A. đại bộ phận lãnh thổ nằm ngoài hai đường chí tuyến.
B. đại bộ phận lãnh thổ nằm giữa hai đường chí tuyến.
C. có nhiều hoang mạc và bán hoang mạc.
D. chịu ảnh hưởng mạnh mẽ của các dòng biển nóng ven bờ.

	
MÔN: GDCD
I. NỘI DUNG ÔN TẬP. Ôn các bài từ tuần 1 đến hết tuần 14. Trong đó, trọng tâm kiến thức:
- Bài 8: Khoan dung
- Bài 9: Xây dựng gia đình văn hóa
- Bài 10: Giữ gìn và phát huy truyền thống tốt đẹp của gia đình dòng họ.
* Yêu cầu :
- Học sinh nắm được khái niệm, biểu hiện, ý nghĩa, cách rèn luyện của phẩm chất đạo 
đức đã học...
- Vận dụng các kiến thức đã học vào giải quyết các tình huống trong thực tế...
* Lưu ý: Các câu hỏi trắc nghiệm sẽ lấy trong nội dung bài học. Dưới đây là một số câu hỏi trắc nghiệm gợi ý.
Câu 1: Gia đình hòa thuận, hạnh phúc, tiến bộ, thưc hiện kế hoạch hóa gia đình đoàn kết với xóm giềng và làm tốt nghĩa vụ công dân được gọi là?
       A.Gia đình hiện đại                                         C. Gia đình kiểu mẫu
       B. Gia đình tiến bộ                                           D. Gia đình văn hóa
     Câu 2: Hành vi nào thể hiện sự yêu thương con người?
A. Cười trên sự đau khổ của người khác
B. Giúp đỡ người khác để được tiếng tốt và nổi danh
C. Chế giễu người tàn tật
D. Giúp người tàn tật hòa nhập với cuộc sống cộng đồng
     Câu 3: Sống đoàn kết, tương trợ mang lại cho chúng ta lợi ích gì?
     A. Dễ bị thiệt thòi và bị người khác lợi dụng
     B. Không có nhiều bạn bè
     C. Dễ dàng hòa nhập và hợp tác với người xung quanh
     D. Có thói quen ỷ lại vào người khác
     Câu 4: Câu tục ngữ nào nói đúng về đức tính khoan dung?
      A. Đánh kẻ chạy đi/ không ai đánh người chạy lại.
      B. Lá lành đùm lá rách
      C. Một sự nhịn là chín sự lành
      D.Uống ước nhớ nguồn.
 Câu 5: Cảm thông, chia sẻ và có việc làm cụ thể giúp đỡ lẫn nhau thể hiện truyền thống gì của dân tộc ta?
      A. Tôn trọng kỉ luật
      B. Yêu thương con người
      C. Đoàn kết, tương trợ
      D. Khoan dung 

     Câu 6: Việc giữ gìn và phát huy truyền thống tốt đẹp của gia đình, dòng họ  đem lại ý nghĩa gì?
A. Góp phần làm phong phú truyền thống, bản sắc dân tộc Việt Nam
B. Góp phần làm giàu cho bản thân và gia đình
C. Thể hiện đẳng cấp của dòng họ có truyền thống tốt đẹp
D. Nâng cao phẩm giá của mỗi người trong gia đình
Câu 7: Biểu hiện của gia đình văn hóa là gì?
A. Gia đình có bố mẹ là cán bộ nhà nước
B. Gia đình giàu có, con cái sành điệu
C. Gia đình đông con, nghèo nàn
D. Gia đình hòa thuận, đoàn kết với xóm giềng
Câu 8: Để trở thành người có lòng khoan dung, chúng ta không nên làm điều gì trong những việc làm dưới đây?
A. Chăm chú lắng nghe để hiểu mọi người
B. Cởi mở, gần gũi, cư xử chân thành, rộng lượng
C. Hay chê bai người khác
D. Thông cảm, thứ tha cho những lỗi nhỏ của bạn bè
Câu 9: Trong lúc học bài: ”Sống giản dị” Bạn Thanh nêu ý kiến với cô giáo và cả lớp rằng: Đức tính giản dị chỉ thực sự cần thiết khi dân ta còn nghèo khó, cuộc sống còn vất vả thiếu thốn. Còn bây giờ đất nước phát triển hàng hóa phong phú nên không cần phải tiết kiệm và giản dị nữa, có như thế mới thể hiện được sự phát triển của đất nước ta. Nếu em là bạn của Thanh em sẽ khuyên bạn điều gì?
A. Giản dị là đức tính không phụ thuộc vào việc giàu hay nghèo, mà trong hoàn cảnh nào chúng ta cũng cần rèn luyện. Nếu sống xa hoa, lãng phí con người sẽ không trân trọng
 sức lao động của mình và của người khác.
B. Xã hội càng phát triển, con người càng phải thể hiện mình là con người sáng tạo, năng động.
C. Nếu không ăn chơi người khác nghĩ mình nghèo không có điều kiện. 
D. Sống là phải đua đòi chạy theo mốt mới thể hiện xu thế hội nhập và phát triển.
Câu 10: Câu tục ngữ, ca dao nào nói về  tự tin và bản lĩnh?
A. Run như cầy sấy
B. Ngựa non háu đá
C. Nhát như thỏ đế
D. Dù ai nói ngả nói nghiêng /Lòng ta vẫn vững như kiềng ba chân
Câu 11: Các bạn lớp 7A đã tập hợp lại với nhau thành lập một bang hội và đặt tên là:
 ”nhóm rồng xanh” để đi gây sự, đánh lộn với các lớp khác. Nếu em là bạn của các 
bạn lớp 7A em sẽ khuyên các bạn điều gì?
    A. Làm như vậy giúp lớp 7A có thêm sức mạnh
    B. Giúp lớp 7A không sợ bất kì lớp khác
    C. Báo cáo với giáo viên chủ nhiệm để giải quyết kịp thời
    D. Lớp 7A thể hiện sự đoàn kết, tương trợ mà các lớp khác không có.
Câu 12: Người có lòng tự trọng là người luôn...
   A. cư xử đàng hoàng, đúng mực                               B. tự ti về bản thân
   C. cư xử nịnh trên nạt dưới                                        D. tự cao, tự đại
Câu 13: Tự tin và bản lĩnh là gì?
A. Tin tưởng vào khả năng của bản thân; hành động cương quyết, dám nghĩ, dám làm
B. Tin tưởng vào khả năng của bản thân nhưng không dám thể hiện 
C. Không tự quyết định được mọi việc của mình
D. Luôn dao động trước những ý kiến trái chiều
Câu 14: Luôn tôn trọng, thông cảm và biết tha thứ cho người khác khi họ hối hận và sửa chữa lỗi lầm thể hiện đức tính gì?
A. Khoan dung               B. Biết ơn              C. Tiết kiệm                    D. Lễ độ
Câu 15: Chọn từ thích hợp để hoàn thiện khái niệm sau:
Giữ gìn và phát huy truyền thống tốt đẹp của gia đình, dòng họ là tiếp nối,………..và làm…………thêm truyền thống ấy.
	A. phát huy/ rạng rỡ
	C. phát triển/ sáng ngời

	B. phát triển/ rạng rỡ
	D. phát huy/ sáng ngời


Câu 16: Hành vi nào thể hiện đức tính trung thực?
 A. Làm bài hộ bạn
 B. Nhận lỗi thay bạn
 C. Bao che thiếu sót cho người đã giúp đỡ mình
 D. Thẳng thắn phê bình khi bạn mắc khuyết điểm
Câu 17: Hành vi nào thể hiện không tự trọng?
    A. Vì hoàn cảnh khó khăn, phải bán hàng rong nửa buổi nhưng Tâm vẫn không mặc cảm mà luôn cố gắng trong học tập tốt.
B. Không làm được bài, nhưng kiên quyết không quay cóp và không nhìn bài của bạn.
C. Nếu có khuyết điểm, khi được nhắc nhở, Nam đều vui vẻ nhận lỗi và hứa sẽ sửa sai.
D. Đang chơi với bạn bè Lan rất xấu hổ khi gặp cảnh bố mẹ mình lao động vất vả.
    Câu 18: Biểu nào thể hiện sự đoàn kết tương trợ?
    A. Hương chỉ chơi thân với bạn gia đình có điều kiện
B. Lôi kéo một số bạn trong lớp để thành lập nhóm chống lại người khác khi có ai bắt nạt.
C. Rủ các bạn trong lớp hùa nhau vào trêu Lan, cô gái mới chuyển đến học của lớp.
D. Cả lớp thảo luận sôi nổi để tìm ra cách giải quyết hợp lý nhất, tình huống mà giáo viên nêu ra.
    Câu 19: Hành vi thể hiện thái độ tôn sư trọng đạo?
     A. Ngày chủ nhật, Năm ra chợ gặp cô giáo. Năm đứng nghiêm bỏ mũ ra chào cô.
     B. Thầy Minh cho bài tập về nhà làm, vì mãi chơi nên Quân không làm
 C. Thầy Sơn chỉ dạy thay cô chủ nhiệm một tiết hôm cô ốm, nên gặp thầy Sơn ở hành lang Tuấn đã không chào thầy.
     D. Gặp thầy cô giáo bộ môn Hùng quay đi không chào.
Câu 20: Câu ca dao, tục ngữ  trái với đoàn kết tương trợ?
      A. Đồng tâm hiệp lực                                     C. Ngựa có bầy chim có bạn
      B. Chung lưng đấu cật                                    D. Phận ai người ấy lo

II. CÂU HỎI ÔN TẬP.
Câu 1 : Thế nào là khoan dung? Em hãy nêu hai biểu hiện của lòng khoan dung trong cuộc sống?
Câu 2: Vì sao chúng ta cần phải sống khoan dung với mọi người? Em hãy nêu cách rèn luyện của bản thân để trở thành người có lòng khoan dung?
Câu 3: Thế nào là gia đình văn hóa? Vì sao chúng ta cần phải xây dựng gia đình văn hóa?
Câu 4: Là thành viên trong gia đình, em cần có trách nhiệm gì để góp phần xây dựng gia đình mình trở thành gia đình văn hóa?
Câu 5: Truyền thống gia đình, dòng họ có ảnh hưởng đối với mỗi con người như thế nào? Em tự hào về điều gì về gia đình, dòng họ của mình?

BÀI TẬP TÌNH HUỐNG . Học sinh làm các bài tập trong SGK vận dụng kiến thức lý thuyết vào giải quyết các vấn đề trong cuộc sống.
Tình huống 1: Hằng và Lan ngồi cạnh nhau trong lớp. Một lần, Hằng vô ý làm dây mực ra vở của Lan. Lan nổi cáu, mắng Hằng và cố ý vẩy mực vào áo Hằng. 
 Câu hỏi: 
 a. Em hãy nhận xét về hành vi của Lan
 b. Nếu em là bạn của Lan và Hằng, em sẽ làm gì? 
 c.Từ tình huống trên, em rút ra được bài học gì cho bản thân mình? 
Tình huống 2: Bố mẹ M đều học hành cao, bố là tiến sĩ, mẹ là thạc sĩ, đều giữ chức vụ quan trọng trong cơ quan nhà nước. Điều kiện kinh tế gia đình M rất khá giả. M rất hãnh diện với các bạn và cho rằng mình chẳng cần học hành nhiều cho vất vả mà vẫn có cuộc sống đàng hoàng, vì đã có bố mẹ lo cho mình.
Câu hỏi:
a. Nhận xét việc làm và suy nghĩ của M, việc là và suy nghĩ của M đã giữ gìn và phát huy truyền thống tốt đẹp của gia đình, dòng họ không? Vì sao?
b. Nếu là bạn của M, em sẽ khuyên bạn điều gì ?
c. Qua tình huống trên, em rút ra bài học gì cho bản thân mình?



	MÔN: CÔNG NGHỆ
A/ HỆ THỐNG KIẾN THỨC
Học sinh cần nắm được kiến thức về:
1.Cách sử dụng và bảo quản các loại phân bón thông thường
2. Vai trò của giống và các phương pháp chọn tạo giống cây trồng
3. Cách sản xuất và bảo quản giống cây trồng
4.Sâu, bệnh hại cây trồng
5. Phòng, trừ sâu, bệnh hại cây trồng
6. Làm đất và bón phân lót.

B/ CÂU HỎI ÔN TẬP
Câu 1: Có những thời kỳ bón phân  nào? Phân loại? Nêu cách bảo quản phân bón?
Câu 2: Giống cây trồng có vai trò như thế nào trong trồng trọt? Nêu tiêu chí của giống cây trồng tốt?
Câu 3: Nêu những điều kiện cần thiết để bảo quản tốt hạt giống?
Câu 4: Nêu tác hại của sâu bệnh? Những dấu hiệu thường gặp khi cây bị sâu, bệnh phá hoại?
Câu 5: Thế nào là biến thái của côn trùng? Có mấy kiểu biến thái? 
Câu 6: Nêu những nguyên tắc trong phòng trừ sâu, bệnh hại? Có những biện pháp phòng trừ sâu, bệnh hại nào? Nêu ưu, nhược điểm của từng biện pháp?
Câu 7: Khi sử dụng thuốc hóa học trừ sâu, bệnh ta cần đảm bảo các yêu cầu gì?
Câu 8: Nêu các công việc làm đất trước khi gieo trồng cây nông nghiệp? Bón lót thì bón loại phân gì và thực hiện như thế nào?

	MÔN: TIẾNG ANH
A/ Vocabulary
              Review vocabulary of	- Unit 1: My hobbies
- Unit 2: Health
- Unit 3: Community Service
- Unit 4: Music and Arts
- Unit 5: Vietnamese Food and Drink
- Unit 6: The first University in Viet Nam
B.Pronunciation: 
	- sounds /ə/ and /ɜː/
 - sounds /f/ and /v/
 - sounds /g/ and /k/
	-  sounds / ʃ / and / ʒ /
-  sounds /ɒ/ and /ɔː/
- sounds /tʃ/ and /dʒ/


C. Grammar: 
I. Simple present tense, Present progressive tense, Near future, Simple future tense, Simple past tense, Present perfect tense: 
II) Comparisons:
1) Comparative and superlative form (So sánh hơn và so sánh nhất):
2. So sánh bằng : S + tobe+ as + adj + as + Pronoun/clause
3. So sánh không bằng : S + tobe + not+ as/so + adj + as + Pronoun/clause
4. So sánh giống nhau : S + tobe + the same as + Pronoun/clause
5. So sánh khác nhau : S + tobe + different from + Pronoun/clause
III) Cấu trúc đồng tình : Too, Either
-“Too” được dùng để diễn tả ý đồng tình với một điều khẳng định trước đó và "too" thường đứng ở cuối câu.
Ex: Tom is interested in dancing, and Kate is interested in dancing, too.
-“Either” dùng trong câu phủ định và để đồng tình với một điều phủ định trước đó. “Either” cũng đứng ở cuối câu và trong câu đồng tình rút gọn chúng ta cần sử dụng các trợ động từ ở dạng phủ định.
Ex: My sister doesn't know the name of that singer and I don't know, either.
IV) Compound sentences: We can link two simple sentences to form a compound sentence using a coordinating conjunctioncs: and (for addition), or (for choice), but (for contrast), so (for a result)….
Eg: You should eat less fast food, or you can put on weight. 
V) Imperatives with more and less:
- We can use the imperative for direct commands, orders or suggestions. 
Eg: Eat less junk food and do more exercise. 
VI) Countable and uncountable nouns:  
VII) How much/ How many: used to ask about quantity.
VIII.  A /An/Some/Any
-“Any” được dùng trong câu phủ định và câu hỏi.
Ex: Do you have any idea for this problem?
IX) Passive voice: 	 
· Present simple 
  		S + V/Vs-es + O          S + am/is/are +P2 + (by O) + time 
· Past simple
		S + Ved / P1 + O          S + was/were +P2 + (by O) + time
Exercises
I. PHONETICS
A. Choose the word which has the underlined part pronounced differently from the rest.
1. A. usually			B. composer		C. leisure		D. version
2. A. prefer			B. perform		C. painter		D. concert
3. A. vision			B. decision		C. sure			D. measure
4. A. hot				B. cottage		C. compose		D. lot
5. A. arrived			B. worked		C. performed		D. showed
6. A. cheap			B. chicken		C. chef			D. children
7. A. bottle			B. fork			C. pork		D. inform
8. A. burn			B. hurt			C. turn			D. yoghurt
9. A. nurse			B. picture		C. surf			D. return
10. A. knife			B. leaf			C. of			D. life
B. Choose the word whose stressed pattern is different from that of the others.
	1. A. usual
	B. unique
	C. tasty
	D. fragile

	2. A. police
	B. mother
	C. chicken
	D. culture

	3. A. handsome
	B. pretty
	C.  friendly
	D.  alone

	4. A. sticky
	B. salad
	C. future
	D. arrive

	5. A. donate
	B. control
	C. construct
	D. open

	6. A. eggshell
	B. machine
	C. nation
	D. guitar

	7. A. custom 
	B. painting
	C.  collect
	D.  hobby

	8. A. famous
	B. village
	C. noodles
	D. design

	9. A. generation
	B. communicate
	C. historical
	D. environment

	10. A. museum
	B. pagoda
	C. composer
	D. different


II. Choose the best answer
1. Her hobbies are …………………. photographs and collecting coins.
A. taking		B. design		C. organizing		D. decorated
2. –I don’t like the new game show on VTV1 now. - I don’t like it …………….
A. too		B. either		C. so 			D. neither
3. The music festival will be at the …………… time as last year.
A. same		B. different		C. more		D. most
4. A ………………… is a person who plays a musical instrument or writes music, especially as a job.
A. poet		B. singer		C. comedian		D. musician
5. His daughter wants to become a well-known …………… but she has no talent at all.
       A. act		B. actor		C. actress		D. action
6. My sister’s personality is very different ……………… mine
        A. as		B. than			C. from		D. the same as
7. Please eat ……………. much …………………. you like.
      A. as/from	            B. the same/as	   	C. different/ from	D. as/as
8. Duong can draw animals, and Duy can do it………………
     A. too		B. either		C. so			D. neither
9. Mozart was one of the most famous …………… of classical music.
     A. actors		B. composers		C. artists		D. makers
10. The music festival this year is as good ……………. it was last year. 
A. as		B. from		C. that			D. the same
11. Bui Xuan Phai is my favourite artist. I love his………………… of the old Ha Noi street. 
A. portrait		B. museum		C. painting		D. opera
12. I think photography is an interesting art form. Of course, having a good…………… is important.
A. paintbrush	B. microphone		C. crayons		D. camera
13. Your taste in art is quite different ……………. mine.
A. than		B. from		C. as			D. the same as
14. How about ……………. to the cinema?
A. go		B. to go	C. going			D. went
15. I think ………………. is very boring.
A. paint		C. to paint		C. paints		D. painting
16. ………………… milk do you drink every morning?
	A. How many		B. Is there	C. How much		D. How little
17. Let’s have noodles with ………………. beef or pork.
	A. any			B. a		C. any			D. some
18. Would you like to go to the movies with me ? ………………………………
	A. Yes, please 	B. Yes, I’d love to 	C. Yes, I do 	D. You are
19. “Stop, please! That is too …………………. coffee!” Hoa told Hung.
	A. many 		B. lots of 	C. much		D. little 
20. ………… money for the poor is her favourite hobby.
	A. To raise		B. Raise	C. Raising		D. Raised
21. This river is … that one.
1. as length as 	B. the same length	C. like length		D. as deep as
22. He is … my father, but he looks young.
1. the same age of 	B. as old		C. the same age as	D. so old as	
23. The story is very interesting. I … it several times.
1. have read		B. am reading		C. read			D. haven’t read
24. We … to New York last summer.
1. flew 		B. we are going to fly	C. we are flying 	D. have flown
25. Your bag is different … her bag.
1. So			B. for			C. from		D. in
26. My friend draws many beautiful pictures. He is a …
1. teacher		B. farmer		C. painter		D. singer
27. Arts are of great … in education, especially for young children.
1. important		B. importance		C. unimportant	D. unimportance
28. Classical music is not … as pop music.
1. as exciting 		B. as excited		C. exciting 		D. more excited
29. I never watch ballet, and my sister doesn’t, …
1. too			B. so			C. either		D. like that
30. My cousins, Mai, is the same age … me.
1. like			B. to			C. of			D. as
31. You can see many interesting …. in that art gallery.
1. portraits		B. actors		C. paints		D. colors
32. Today, subjects like music and arts are put into the school … in Vietnam.
1. curriculum 		B. education  		C. school year		D. subjects
33. How many ………… are there in your classroom?
1. studentes 		B. students		C. student		D. a student
34. Lan is hungry. She’d like some…………
1. coffee			B. sweets		C. oranges		D. noodles
35. There isn’t ………… rice in the packet
1. some 			B. any			C. a			D. an
36. A …….… is a small meal that you eat when you are in a hurry.
1. snack 			B. fast food		C. breakfast		D. lunch
37. How many ……… do you want?
1. orange juice	B. bottle of orange juice 	C. jar of orange juice 	D. cartons of orange juice
38. Cakes in Vietnam are made ………. butter, eggs and flour.
1. in			B. from 		C. of			D. by
39. Do you want to … this new dish of noodles I have just cooked?
1. like			B. try 			C. drink		D. make
40. I am in trouble. Would you mind giving me …?
1. a few advice		B. some advice 		C. advices		D. several advices
  III . Find and correct mistake
1. You should eat   more junk food because it makes you fat.			………………………..
2. My sister enjoys to collect  dolls.							………………………..
3. I think dance is very interesting.							……………………...	
4. I’d love coming to your birthday but I’m much too busy.			 ………………………..
 5.    I don’t want much sugar in my coffee. Just a few, please.			………………………..
 6.    On the table there were vegetables, bread and two large bowls of soups.	………………………..
 7.   My brother doesn’t like pork and I don’t too.					………………………..
 8.   Trung gives often Chi a box of chocolate.					………………………..
 9    I  have enough food in the house, so I needn’t going to the shops tomorrow.	 ………………………..
10.  May I have any sugar?								………………………..
IV. Circle the letter A, B, C or D to indicate the word OPPOSITE in meaning to the underlined word(s)
1. Do you fancy collecting old dolls? 
A. interested			     B. enjoy		C. like		D. dislike
2.  Water puppetry is a unique Vietnamese tradition.     
A. normal       			     B. popular        	C. special       	D. old
3. This dish is a little sweet.                                           
A. spicy          			     B. salty                      C. bitter             D. tasty
V. Circle the letter A, B, C or D to indicate the word CLOSEST in meaning to the underlined word(s) 
1. The film was exciting last night.      
 	A. nice       		B. interesting       		C. old          	D. new 
2. I enjoy swimming because it is very interesting and it helps me staying in shape. 
A. healthy	     	B. keeping fit			C. obesity	D. sleeping well
3. I would like six apples.                                            
 A. a dozen    		B. half a dozen     		C. a kilo         	D. a slice
  VI. Choose the best response
1. “Would you like to join our volunteer group this summer?” - “ ……………”
A. Do you think I would?          B. I wouldn’t thank you   C. Yes, you are a good friend    D. Yes, I’d love to, thanks
2. “Which hat do you like best?” - “ ………………..”
A. Yes, I like it best       B. The one I tried on first      C. Which one do you like?   D. No, I haven’t tried any
3. “Our team has just won the last foot ball match.” - “ …………………….”
	A. Good idea. Thanks for the news                       C. Yes, I guess it’s very good
	C. Well, that’s very surprising!                           	D. Yes, it’s our pleasure    
4. Mai: “Do you want another serving of chicken soup?”   Scott: “………………….”
A. No way                B. No comment          C. No thanks               D. No longer
5. Jack: “What’s wrong with you?”               Jill: “…………………”
A. Thank you very much   B. I’m having a slight headache   C. No, I don’t care    D. Yes, I was tired 

 VII. READING COMPREHENSION
1. Choose the right answers.
Once a farmer (26)______ a comfortable life with his family. His chickens laid many eggs which the farmer used to (27)______ to buy food and clothing for his family. 
One day, he (28)______ to collect the eggs and discovered one of the chickens laid a gold egg. He shouted excitedly to his wife, “We’re rich! We’re rich!”
His wife (29)______ to him and they both looked at the egg in amazement. The wife wanted more, so her husband decided (30)______ open all the chickens and find more gold eggs. Unfortunately, he couldn’t find any eggs. When he finished all the chickens were dead. 
There were no more eggs of any kind for the foolish farmer and his greedy wife.
1. A. lived	B. live	C. lives	D. living
2. A. selling	B. sell	C. sells	D. sold
3. A. go	B. goes	C. went	D. is going
4. A. run	B. runs	C. is running	D. ran
5. A. cutting	B. to cut	C. cut	D. A&B

2. Read the passage and choose the correct answer
Modern Talking was the pop duo of Thomas Anders and Dieter Bohlen who started the group in 1984. Modern Talking is often thought of as the most successful German duo with over 120 million records sold worldwide
The two singers parted ways after an argument in 1987, but they reunited in 1998 and stayed together as a group until 2003. The band was extremely popular in the 1980’s due to their extravagant fashion style and their catchy songs such as “You are my heart, you are my soul” and “Cheri, Cheri Lady”
Today both musicians are pursuing their own musical careers. Bohlen is well – known as tough judge on the German version of “American idol’ 
1. Modern Talking was established in …
1. 1980  		B. 1984			C.1988			D. 1992
1. Modern Talking had …. records  worldwide
1. Over 1.2 million 	B. over 12 million	C. over 120 million  	D. over 120 billion
1. The two singers parted ways because of …
1. An argument   	B. their own business	C. having no time	D. their own family
1. The band was extremely popular in the 1980’s because of …
1. Singer’s handsomeness		B. singer’s excellent voice	C. scandals	
D. their extravagant fashion style and their catchy songs
1. Bohlen is famous in German as a …
1. Game show judge		B. singer 		C. musician		D. composer
VIII. WRITING
 * Mark the letter A, B, C or D to indicate the sentence that is closest in meaning to each of the following sentences.
1. They started playing tennis in 2003.
A. They have started playing tennis for 2003.    B. They have played tennis for 2003.
C. They have played tennis since 2003.              D. They have started playing tennis since 2003
2.I have not met her for three years.
A. The last time I met her was three years ago.          B. It is three years when I will meet her.
C.I did not meet her three years ago.                          D. During three years, I met her once.
3. I can't cook as well as my mother does.
A. My mother can cook better than I can.     B. My mother can't cook better than I can.
C. My mother can cook well than I can.      D. I can cook better than my mother can
4. She is older than me.
A. I’m more younger than her.				B. I’m as younger as her.
C. I’m more young than her.					D. I’m younger than her.
5. I/ cook/ dinner/ half an hour/ ago.
A. I cook a dinner half an hour ago.
B. I cooked dinner half an hour ago.
C. I am cooking dinner half an hour ago.
D. I cooked a dinner half an hour ago.
6. It/ often / take/ 30 minutes/ review/ lesson/ class.
A. It often takes me 30 minutes reviewing our lesson before class.
B. It often take me 30 minutes to review our lesson before class.
C. It often takes me 30 minutes to review our lesson before class.
D. It often take me 30 minutes  to reviewing our lesson before class
7.This picture is the same as the picture in our room. ( not different from)
A. This picture is not different from as  the picture in our room
B. The picture in our room is not different from this one
C. The picture in our room  not different from this one
D. This picture  not different from as  the picture in our room
8. Nick has got some crayons in his bag. (Make question for underlined words)
A.How much crayons does Nick have got in his bag?
B. How much crayons does Nick has got in his bag?
C. How many crayons does Nick have got in his bag?
D. How many crayons does Nick has got in his bag?
9. Lien didn’t go to school yesterday because she had a headache. 
(Make question for underlined words)
A. Why did Lien go to school yesterday?
B. Why didn’t Lien go to school yesterday?
C. Why does Lien go to school yesterday?
D. Why Lien not go to school yesterday?
10. You should eat less fast food. You can put on weight. (Combine two sentences)
A. You should eat less fast food and you can put on weight
B. You should eat less fast food, so you can put on weight
C. You should eat less fast food, but you can put on weight
D. You should eat less fast food, or you can put on weight
11.These photos are not clear. Those aren’t clear. (Combine two sentences)
A. These photos are not clear and those aren’t clear, too
B. These photos are not clear and those aren’t either
C. These photos are not clear and those aren’t neither
D. . These photos are not clear and so those aren’t clear
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